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QUESTION 1

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based network. You want to quickly
filter data in a PivotTable report without opening drop-down lists to find the items that you want to filter. For this purpose,
you are required to use a slicer. Which of the following are the ways that you can use to accomplish the task? Each
correct answer represents a complete solution. Choose all that apply. 

A. Create a copy of a slicer connected with the PivotTable. 

B. Create a slicer connected with the PivotTable. 

C. Create a slicer by disabling Macros associated with the PivotTable. 

D. Use an existing slicer connected with another PivotTable. 

Correct Answer: BAD 

The various ways to use or create slicers to filter PivotTable data in an existing PivotTable are as follows: 

1.

 Create a slicer connected with the PivotTable. 

2.

 Create a copy of a slicer connected with the PivotTable. 

3.

 Use an existing slicer connected with another PivotTable. Answer option C is incorrect. This is an invalid answer
option. 

 

QUESTION 2

You work as a Help Desk Technician for Net Perfect Inc. You use Excel 2010 to create different reports for your
company. Drag and drop the appropriate methods for efficient data entry in front of their descriptions. 

Select and Place: 
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Select and Place: 
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Correct Answer: 
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Excel provides multiple methods for fast data entry into a worksheet. These data entry techniques help users to quickly
enter data wherever required. The following methods help users in speeding-up their data entry work: 

AutoFill: The AutoFill feature recognizes the series a user wants to enter and fills the series when the fill handle is
dragged. 

FillSeries: In FillSeries method, a user enters the first two values in a series and then by selecting both the cells and
dragging the selected cells through the fill handle, extends the series. AutoComplete: The AutoComplete feature
provides 

users a facility to enter few words in a cell. If this entry matches with any of the entries done before in other cells, it
suggests users for the same. The user can press the Enter key to get the same entry in the cell. Pick from Drop- down
List: 
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The Pick from Drop-down List option displays the unique entries from the column of a cell. A user can choose an entry
from the list to quickly fill the entry. 

Ctrl + Enter: Ctrl + Enter key combination is used to quickly fill a range of cells with the same entry. For this, select a
range of cells to contain the same data, type the data in the active cell, and press Ctrl + Enter keys. 

 

QUESTION 3

Rick works as an Office Assistant for Tech Perfect Inc. He is creating a user form through Microsoft Excel 2010. While
creating forms for a number of users, he is required to repeat some of the actions multiple times. It is a very time
consuming process. To resolve this issue, he wants to record the sequence of actions to perform a certain task and to
play them back in the same order. Which of the following actions will Rick take to accomplish the task? 

A. He will use the Trust Center bar. 

B. He will use the Evaluate Formula tool. 

C. He will put the workbook in a trusted location. 

D. He will create and run a macro. 

Correct Answer: D 

A macro is defined as a tool that permits a user to automate tasks and add several functionalities to forms, reports, and
controls. For example, if a user adds a command button to a form, he associates the button\\'s OnClick event to a
macro, 

and the macro consists of the commands that are to be performed by the button each time it is clicked. The macro
records the user\\'s mouse clicks and keystrokes while he works and lets him play them back later. The macro can be
used to 

record the sequence of commands that the user uses to perform a certain task. When the user runs the macro, it plays
those exact commands back in the same order. 
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Answer option B is incorrect. Evaluate Formula is a formula examination tool provided by Microsoft Excel. This tool is
useful for examining formulas that do not produce any error but are not generating the expected result. 

Answer options A and C are incorrect. The benefit of connecting to external data from Microsoft Excel is that a user can
automatically update Excel workbooks from the real data source wheneverthe data source is updated with new 

information. It is possible that the external data connection might be disabled on the computer. For connecting to the
data source whenever a workbook is opened, it is required to enable data connections by using the Trust Center bar or
by 

putting the workbook in a trusted location. 

 

QUESTION 4

You work as an Office Assistant for Dreams Unlimited Inc. You use Microsoft Excel 2010 for creating various types of
reports. You have created a report in the format given below: 

In the A7 cell, you are required to put a formula so that it can fulfill the description provided in the B7 cell. Which of the
following formulas will provide the required result? 

A. COUNTIF(B2:C5,"=Yes") 

B. COUNTIFS(B2:C5,"=Yes") 

C. COUNTIF(B2:B5,"=Yes",C2:C5,"=Yes") 

D. COUNTIFS(B2:B5,"=Yes",C2:C5,"=Yes") 

Correct Answer: D 

In order to get the required result, you will have to insert the following formula in the B7 cell: 

COUNTIFS(B2:B5,"=Yes",C2:C5,"=Yes") 

Only Sarah and David have exceeded their January and February quotas, therefore the formula will provide 2 as the
result. 

Answer option C is incorrect. The COUNTIF function of Excel does not support multiple criteria. Answer options A and B
are incorrect. This formula will count all the cells that have the value "Yes" in the range B2:C5. As multiple criteria are
not 

77-888 PDF Dumps | 77-888 Practice Test | 77-888 Study Guide                              7 / 16

https://www.passapply.com/77-888.html
https://www.passapply.com/77-888.html
https://www.passapply.com/77-888.html


https://www.passapply.com/77-888.html
2021 Latest passapply 77-888 PDF and VCE dumps Download

applied in the formula, it will provide 6 as the result. In the A7 cell, you are required to put a formula so that it can fulfill
the description provided in the B7 cell. 

Which of the following formulas will provide the required result? A. COUNTIF(B2:C5,"=Yes") 

B. COUNTIFS(B2:C5,"=Yes") 

C. COUNTIF(B2:B5,"=Yes",C2:C5,"=Yes") 

D. COUNTIFS(B2:B5,"=Yes",C2:C5,"=Yes") 

Answer: D 

In order to get the required result, you will have to insert the following formula in the B7 cell: 

COUNTIFS(B2:B5,"=Yes",C2:C5,"=Yes") 

Only Sarah and David have exceeded their January and February quotas, therefore the formula will provide 2 as the
result. 

Answer option C is incorrect. The COUNTIF function of Excel does not support multiple criteria. Answer options A and B
are incorrect. This formula will count all the cells that have the value "Yes" in the range B2:C5. As multiple criteria are
not 

applied in the formula, it will provide 6 as the result. 

 

QUESTION 5

You work as an Office Assistant for Tech Perfect Inc. Your responsibility includes preparing sales reports of the
company. You have created a sales report in a workbook of Excel 2010. Your workbook includes several worksheets as
shown in 

the image given below: 

You want the sheet tabs of the sheets containing charts to appear in red color. Which of the following steps will you take
to accomplish the task? 

A. Select the sheets containing charts. Select the Colors option in the Themes group on the Page Layout page. 

B. Select the sheets containing charts. Right-click on the sheet tabs. Choose the Tab Color option from the shortcut
menu. 

C. Select the sheets containing charts. Right-click on the sheet tabs. Choose the Sheet Color option from the shortcut
menu. 

D. Select the sheets containing charts. Select the Effects option in the Themes group on the Page Layout page. 

77-888 PDF Dumps | 77-888 Practice Test | 77-888 Study Guide                              8 / 16

https://www.passapply.com/77-888.html
https://www.passapply.com/77-888.html
https://www.passapply.com/77-888.html


https://www.passapply.com/77-888.html
2021 Latest passapply 77-888 PDF and VCE dumps Download

Correct Answer: B 

According to the question, you want the sheet tabs of the sheets containing chart to appear in red color. In order to
accomplish the task, you will have to take the following steps: 

 

QUESTION 6

You work as a Sales Manager for Maini Industries. Your company manufactures and sells construction equipment. You
have to create a report that will show the highest selling items of each month. The report will be in the following format: 
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In a workbook, you create a table named Item_table as shown below: 

You fill in the required entries in the workbook. 

For the third column of the sheet, you want to use formulas to fill in the values. You want the cells in the third column to
get automatically filled with the names corresponding to ItemID in the second column. You want the exact values to be
filled in the column. You select the C2 cell in the third column. 

Which of the following formulas will you enter in order to accomplish the task? 

A. =VLOOKUP(B2,Item_table,2,FALSE) 

77-888 PDF Dumps | 77-888 Practice Test | 77-888 Study Guide                             10 / 16

https://www.passapply.com/77-888.html
https://www.passapply.com/77-888.html
https://www.passapply.com/77-888.html


https://www.passapply.com/77-888.html
2021 Latest passapply 77-888 PDF and VCE dumps Download

B. =VLOOKUP(B2,Item_table,2,TRUE) 

C. =VLOOKUP(2,Item_table,B2,FALSE) 

D. =VLOOKUP(2,Item_table,B2,TRUE) 

Correct Answer: A 

In order to accomplish the task, you will use the following formula: 

=VLOOKUP(B2,Item_table,2,FALSE) 

Answer option B is incorrect. According to the question, you want the exact values in the column. The TRUE value in
the range_lookup argument provides the approximate match. Answer options C and D are incorrect. The VLOOKUP 

functions used in the formulas have wrong syntaxes. 

 

QUESTION 7

You work as an Office Assistant for Tech Perfect Inc. You are working in the spreadsheet of the company\\'s high selling
products. You are trying to intersect two ranges that do not intersect each other. Which of the following errors will be
occurred in this situation? 

A. #VALUE! 

B. #NAME? 

C. #NULL! 

D. #DIV/0! 

Correct Answer: C 

The #NULL! error is produced by Excel when a user attempts to intersect two ranges that do not intersect each other.
This error can be resolved by reviewing the formula and then either by changing the variables to ensure that the user is
getting a valid intersection or by using the Excel Iferror function to identify a null range and take the required action.
Answer option D is incorrect. Excel #DIV/0! is produced when a formula attempts to divide by zero and a division by
zero produces infinity that cannot be represented by a spreadsheet value. This error can be corrected or overcome by
using the Excel IF function to identify a possible division by zero and produce an alternative result. Answer option A is
incorrect. The #VALUE! Excel formula error occurs when any of the variables in a formula is of the wrong type. To
correct this error, it is required to check each individual part of the formula to make sure that the correct argument types
are used. If the function contains nested functions, the best way is to copy each of the arguments into a separate cell to
check what they evaluate to. If the formula contains a number of terms, break down each term further to find out its
components, until the source of the error is found. Answer option B is incorrect. The #NAME? error occurs when Excel
encounters text in a formula and tries to interpret that text as a reference, a named range, or a function name but is not
able to recognize the text as any of these. The best way to approach the #NAME? Excel function error is to check the
correct spelling of the function names, references, and named ranges and to check that the variables used as text
values are entered in double quotes. If the formula contains nested functions, it is required to check the results of these
individually, until the source of the error is identified. 

 

QUESTION 8

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based network. You want to filter data
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in a PivotTable report without opening drop-down lists to find the items that you want to filter. For this purpose, you are
using a slicer. After filtering the data, you want to disconnect the slicer. You have clicked anywhere in the PivotTable
report. Which of the following steps will you take next to accomplish the task? 

Each correct answer represents a part of the solution. Choose all that apply. 

A. Clear the check box of any PivotTable fields for which you want to disconnect a slicer. 

B. Right-click the slicer, and then click Remove . 

C. Click the Insert Slicer arrow, and then click Slicer Connections on the Options tab in the Sort and Filter group. 

D. Click the slicer, and then press Delete. 

Correct Answer: CA 

 

QUESTION 9

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based network. You want to get the
trend of the Business data range. For this purpose, you want to use trendlines in the chart. Which of the following steps
will you take to apply the trendlines in the chart? Each correct answer represents a part of the solution. Choose all that
apply. 

A. Clear the check box of any Trendline fields to disconnect a slicer. 

B. Select the type that you want from Trendline options. 

C. Click the Insert Trendline arrow, and then click Trendline Connections on the Options tab in the Sort and Filter
group. 

D. Select a chart and then navigate to the Chart Tools Layout tab. 

Correct Answer: DB 

 

QUESTION 10

You work as an Office Assistant for Tech Tree Inc. You have created a report in a workbook in Microsoft Excel 2010.
You want to export XMLdata to your Excel 2010 worksheet. On exporting the XML data, the following error message 

appears: 

"XML MAPS IN MY WORKBOOK ARE NOT EXPORTABLE" 

Which of the following are the reasons that are causing the above error? Each correct answer represents a complete
solution. Choose all that apply. 

A. The maxoccurs attribute is not equal to 1. 

B. The relationship of the mapped element with other elements is not preserved. 

C. The element is a recursive structure. 

D. The XML map associated with this XML table contains one or more required elements that are not mapped to the
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XML table. 

Correct Answer: AB 

The various issues with exporting XML data are as follows: 

1.

 MAP CAN BE EXPORTED BUT SOME REQUIRED ELEMENTS ARE NOT MAPPED: 

This error occurs under the following situations: 

The XML map associated with this XML table contains one or more required elements that are not mapped to the XML
table. The element is a recursive structure. 

The XML table contains a variety of mixed content. 

2.

 EXCEL CANNOT SAVE THE WORKBOOK BECAUSE IT DOES NOT CONTAIN ANY XML MAPPINGS: Excel cannot
save the user\\'s workbook in the XML Data file unless one or more mapped ranges are created. 

3.

 XML MAPS IN MY WORKBOOK ARE NOT EXPORTABLE: An XML mapping cannot be exported if the relationship of
the mapped element with other elements is not preserved due to the following reasons: 

The mapped element\\'s schema definition is contained within a sequence with the following attributes: 

The maxoccurs attribute is not equal to 1. 

The sequence has more than one direct child element defined or has an extra compositor as a direct child.
Nonrepeating sibling elements with the same repeating parent element are mapped to dissimilar XML tables. 

Various repeating elements are mapped to the same XML table and the recurrence is not defined by an ancestor
element. 

Child elements from various parents are mapped to the same XML table. XML schema constructs a list of lists,
denormalized data, or a choice construct. 

 

QUESTION 11

Rick works as an Office Assistant for Tech Perfect Inc. He is creating a report through Microsoft Excel 2010. He wants
to fill the active cell with the content of the adjacent cell. Mark the option that he will choose to accomplish the task. 

Hot Area: 
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Correct Answer: 

 

 

QUESTION 12

You work as a Project Manager for Blue Well Inc. The company has a Windows-based network. 

You want to rename a worksheet as Important. 

Which of the following steps will you take to accomplish the task? Each correct answer represents a part of the solution.
Choose all that apply. 

A. Click the Insert tab and open the name sheet. 

B. Enter the name and click the OK button. 

C. Right-click on the Sheet tab and select the Rename option. 

D. Delete the old name, type the new name, and then click OK. 

Correct Answer: CB 
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